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Interfaces Gráficas do Usuário do MOHID (Visão 
Geral)

1.1 Introdução

As interfaces gráficas do usuário do ‘MOHID Sistema de Modelagem 
de Água’ são um conjunto de programas para pré e pós-processar a 
entrada e a saída de dados necessários para os diferentes programas 
numéricos. Esta seção descreve como as interfaces do usuário integradas 
no ‘MOHID Sistema de Modelagem de Água’ funcionam e interagem com 
os códigos numéricos.

Depois de instalar o ‘MOHID Sistema de Modelagem de Água’, o 
usuário pode acessar as interfaces gráficas do usuário do MOHID, 
selecionando Start (Iniciar) -> All Programs (Todos os programas) -> 
Mohid, como mostrado na figura 1-1.

Figura 1-1: Acesso à Interface Gráfica do Usuário do MOHID após a instalação do 
programa

1
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As principais interfaces gráficas do usuário são:
• MOHID GUI - uma interface gráfica do usuário para gerir a organização 

estrutural de todos os arquivos que são necessários para configurar uma 
simulação numérica do MOHID;

• MOHID GIS - um sistema de informação geográfica capaz de gerir os 
dados das variáveis de tempo e espaço requeridos ou produzidos pelos 
programas numéricos do MOHID;

• MOHID Post – uma interface gráfica do usuário que exibe dados 
armazenados em arquivos HDF como animações na tela;

• MOHID Time Series Editor – uma interface gráfica do usuário que 
permite a visualização, de modo rápido, dos dados das séries temporais 
requeridos ou produzidos por programas numéricos do MOHID.

As trocas de dados entre as Interfaces Gráficas do Usuário do MOHID 
e os programas numéricos do MOHID são realizadas por arquivos. 
Existem dois tipos de arquivos que são usados: (i) os arquivos de texto 
ASCII que seguem uma formatação adequada e (ii) os arquivos HDF. 
Mais informações podem ser encontradas no documento “MOHID Data 
Files – Overview”.

Nas seções seguintes, é descrito como este conjunto de programas 
funciona.
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MOHID GUI (Interface Gráfica do Usuário)

2.1 Introdução

A MOHID GUI é uma interface gráfica do usuário para gerir a 
organização de entrada e saída de arquivos exigidos pelos programas 
numéricos do MOHID. Na versão atual, a MOHID GUI pode atuar como 
interface do usuário para os seguintes programas numéricos:

• MOHID Water – programa numérico que permite a simulação de 
massas de água superficial;

• MOHID Land – programa numérico que permite a simulação de 
bacias hidrográficas;

• MOHID River Network – programa numérico que permite a simulação 
de redes hidrográficas;

• MOHID Soil – programa numérico que simula a dinâmica de solos de 
pequenas escalas.

A janela principal da MOHID GUI é dividida em três áreas: (i) a exibição 
em árvore acoplada à borda esquerda da janela principal, (ii) a exibição 
em lista localizada no lado superior direito da janela principal e (iii) uma 
caixa de texto localizada no lado inferior direito da janela principal. A 
figura 2-1 mostra um exemplo da janela principal da MOHID GUI.

2
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Figura 2-1: Janela principal da MOHID GUI

A MOHID GUI organiza as simulações, dividindo-as em quatro 
unidades principais: (i) projetos “projects”, (ii) simulações “simulations”, 
(iii) execuções “runs” e (iv) módulos “modules”. A MOHID GUI pode 
funcionar de dois diferentes modos: (i) o modo pré-processamento e (ii) 
o modo pós-processamento.

2.2 Organização Interna

Um projeto é a unidade de mais alto nível e agrupa uma ou mais 
simulações. Apenas um projeto por vez pode ser aberto pela MOHID 
GUI. Cada um dos projetos tem seu diretório de projeto associado, que 
deve ser especificado pelo usuário sempre que um novo projeto é criado. 
Na janela de exibição em árvore, um projeto é sempre representado pelo 
nó de mais alto nível, como mostrado pelo nó Reservoirs na Figura 2-1.

Uma simulação é uma unidade intermediária e agrupa um conjunto 
de execuções. As simulações contêm informações que são comuns a 
todas as execuções de uma determinada simulação. Estas informações 
são:

• O tipo de execuções a serem realizadas (MOHID Water, MOHID 
Land ou MOHID River Network);

• Os dados da base geográfica (batimetria para MOHID Water e 
topografia para MOHID Land);

• Informação das marés para a fronteira aberta (apenas para MOHID 
Water).

No caso do MOHID Water, as simulações podem ser inseridas em 
outras simulações. Isso permite ao usuário criar simulações aninhadas,
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que serão entendidas pela MOHID GUI como uma opção do usuário 
de executar um modelo com um submodelo. Um número infinito de 
simulações aninhadas pode ser inserido, sendo o único limite os 
recursos computacionais disponíveis ao usuário. A figura 2-1 exibe 
quatro simulações: Paracana, Esquematic, MonteNovo e Montargil. A 
janela da caixa de texto pode ser usada para anotar comentários sobre 
a simulação selecionada.

Cada run (execução) corresponde a uma execução do programa 
numérico selecionado e é caracterizado por um período de tempo durante 
o qual uma operação será executada. O run é também constituído pelos 
módulos que serão utilizados durante a execução. Os runs podem ser 
inseridos em outros runs de duas maneiras: (i) como sequência temporal 
ou (ii) paralelos uns aos outros. A figura 2-1 exibe sete runs da simulação 
Montargil, que são paralelos entre si, exceto a execução “Continuous” 
que é uma sequência temporal da execução “LowerWaterTable”. Isso 
significa que as condições iniciais da execução “Continuous” são dadas 
pelo último instante computado do run “LowerWaterTable”.

A janela da caixa de texto pode ser usada para anotar comentários 
sobre o run selecionado.

Módulos

 Os módulos são associados às execuções e estão listados na exibição 
em lista no lado superior direito da janela principal da MOHID GUI. 
Ao selecionar um determinado run na árvore de exibição, os módulos 
correspondentes serão listados na exibição em lista. Caso a MOHID GUI 
esteja no modo pré-processamento, com um clique duplo em um ícone da 
lista em exibição, os arquivos de dados de entrada do módulo selecionado 
serão abertos. Caso a MOHID GUI esteja no modo pós-processamento, 
os arquivos HDF e os arquivos de resultados das séries temporais de 
cada módulo serão listados na exibição em lista. Com um clique duplo 
em um ícone da lista em exibição no modo pós-processamento, a MOHID 
GUI abrirá o MOHID Post (no caso do ícone selecionado corresponder 
a um arquivo HDF produzido por um determinado módulo) ou o MOHID 
Time Series Editor (no caso do ícone selecionado corresponder a um 
arquivo de séries temporais produzido pelo módulo correspondente).

2.3 Passo a passo

Esta seção descreve o passo a passo de como usar a MOHID GUI para 
criar um novo projeto, inserir simulações e execuções e como acessar os 
arquivos de dados dos módulos, executar programas numéricos e como 
iniciar os programas de pós-processamento MOHID Post e MOHID Time 
Series Editor.
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Figura 2-2: Uma janela vazia da MOHID GUI

Um novo projeto pode ser criado selecionando-se Project -> New... 
no menu principal da MOHID GUI. Uma pequena caixa de diálogo, como 
mostrado na figura 2-3, aparecerá e solicitará que o usuário forneça 
informações para o nome do projeto, o nome do arquivo do projeto (a 
extensão deve ser *.moh) e a localização da origem do projeto.

2.3.1 Criando um projeto

Para criar um novo projeto, a MOHID GUI deve ser iniciada 
selecionando-se Start (Iniciar) -> All Programs (Todos os programas) 
-> Mohid -> MOHID GUI. Uma janela vazia da MOHID GUI aparecerá 
(Figura 2-2).

Figura 2-3: Caixa de diálogo para 
especificar as configurações do projeto

Depois de fechar a caixa de diálogo, o nó da origem que corresponde 
ao nó do projeto será inserido na exibição em árvore da janela principal da 
MOHID GUI. Ao fechar a caixa de diálogo, a MOHID GUI criará também 
três subdiretórios no diretório do projeto: (i) um diretório chamado “Figures” 
que pode ser usado para colocar as figuras criadas para o projeto, (ii) um 
diretório chamado “GeneralData” que pode ser usado para armazenar 
dados genéricos (por exemplo: informação da batimetria, arquivos de 
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2.3.2 Inserindo uma simulação

Antes de inserir uma nova simulação em um projeto, o usuário 
deve preparar os dados necessários para tal (por exemplo: o arquivo 
de batimetria para o MOHID Water ou o arquivo de topografia para 
MOHID Land), utilizando o MOHID GIS ou outras fontes. É recomendado 
armazenar esses arquivos no diretório “GeneralData” mencionado 
anteriormente.

Para inserir uma nova simulação, o nó da origem na exibição em 
árvore deve ser selecionado (ou as simulações onde um submodelo será 
inserido). Depois de selecionar o nó desejado, uma nova simulação pode 
ser inserida selecionando-se Edit -> Insert Simulation do menu principal 
da MOHID GUI. Uma caixa de diálogo, como mostrado na figura 2-4, 
aparecerá. Aqui o usuário pode especificar as propriedades da simulação: 
(i) o nome da simulação, (ii) o tipo de simulação, o caminho para os 
arquivos de dados da malha (arquivo batimétrico para o MOHID Water 
ou topográfico para o MOHID Land) e, opcionalmente, o caminho para 
o arquivo que contém os componentes da maré (para o MOHID Water 
somente).

Figura 2-4: Caixa de diálogo para especificar as configurações da simulação

Depois de fechar a caixa de diálogo mostrada na figura 2-4, um nó 
para a simulação será acrescentado na exibição em árvore. Ao fechar 
a caixa de diálogo, a MOHID GUI também criará um subdiretório no 
diretório do projeto, com um nome igual ao nome da simulação. Dentro 
desse diretório, três novos diretórios serão criados: (i) um diretório 

entrada com as condições atmosféricas, etc.) e (iii) um diretório chamado 
“Temp” para colocar arquivos temporários.
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chamado “data”, onde os arquivos de dados de entrada para os módulos 
serão armazenados, (ii) um diretório chamado “exe”, que será utilizado 
por um modelo numérico como diretório de trabalho e (iii) um diretório 
chamado “res”, onde os arquivos de resultados produzidos pelos modelos 
numéricos serão armazenados.

Depois de inserida a simulação, a exibição em árvore deverá 
assemelhar-se com a vista na figura 2-5.

Figura 2-5: Exibição em árvore depois de inserida uma simulação

É possível acessar e alterar as propriedades da simulação selecionando-
se a simulação na árvore de exibição e depois selecionando-se Edit -> 
Properties do menu principal da MOHID GUI.

2.3.3 Inserindo uma execução

Para inserir uma nova execução, o nó da árvore onde a execução 
será inserida deve ser selecionado primeiro. Esse nó pode ser um nó 
de simulação ou um nó de execução, dependendo da opção do usuário 
por inserir uma primeira execução em uma simulação ou uma sequência 
temporal de uma execução já existente. Depois de selecionar o nó 
desejado, uma nova execução pode ser inserida, selecionando-se Edit 
-> Insert Run do menu principal da MOHID GUI. Uma caixa de diálogo, 
como mostrado na figura 2-6, aparecerá. Aqui o usuário pode especificar 
as propriedades da execução: (i) o nome da execução, (ii) a data inicial, 
(iii) a data final, (iv) o intervalo de tempo e (v) a zona GMT. Selecionando-
se a aba “Associated Modules”, o usuário pode escolher os módulos a 
serem ativados para a execução selecionada.

No caso de inserção de uma sequência temporal de uma execução 
já existente, a MOHID GUI definirá a data inicial da execução recém-
inserida automaticamente para a data final da execução anterior, e a data 
final da nova execução, igual à sua data inicial mais um dia.
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Figura 2-6: Caixa de diálogo para especificar as propriedades de uma execução (Run)

É possível acessar e mudar as propriedades da execução selecionando-
se a execução na exibição em árvore, e depois selecionando-se Edit -> 
Properties do menu principal da MOHID GUI.

Cada execução receberá automaticamente um Número de Identificação 
(Identification Number – ID). Todos os arquivos que pertencem a uma 
determinada execução irão conter esse ID no final, antes da extensão 
do arquivo. Por exemplo, o arquivo de entrada de dados para o módulo 
hidrodinâmico da execução com ID 5 será chamado “Hidrodinâmico_5.
dat”.

Depois de selecionar uma determinada execução, seus módulos 
associados serão listados na exibição em lista.

Depois de inserir um conjunto de execuções, a janela da exibição em 
árvore deverá aparecer como mostrado na figura 2-7.

Figura 2-7: Exibição em árvore com um conjunto de execuções
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2.3.4 Acessando os Arquivos de Dados dos Módulos

Como mencionado anteriormente, os arquivos de dados dos módulos 
podem ser acessados com um clique duplo no ícone da lista de exibição. 
Cada vez que o usuário selecionar um nó diferente da exibição em árvore, 
a exibição em lista é atualizada, mostrando os módulos associados à 
execução selecionada. A exibição em lista também mostra, para cada 
módulo, informações como: (i) o caminho relativo ao arquivo de dados, 
(ii) a última vez que o arquivo foi acessado e (iii) o tamanho do arquivo.

Depois do clique duplo, os arquivos de dados dos módulos podem abrir 
de duas maneiras: (i) em um editor de texto definido pelo usuário (que, 
por padrão, é o “Bloco de Notas”) ou (ii) usando uma interface gráfica 
do usuário interna. A primeira forma é mais garantida porque o usuário 
realmente “vê” o que está dentro do arquivo de dados. A segunda forma 
é mais amigável, mas oferece acesso limitado às opções computacionais 
e somente para alguns módulos. Portanto, é recomendado editar seus 
arquivos usando um editor de texto. A figura 2-8 mostra uma tela da 
área de trabalho de um usuário depois de acessar o arquivo de dados 
geométricos.

Todos os arquivos de dados do MOHID são organizados utilizando 
uma formatação adequada, que é descrita em “MOHID Data Files – 
Overview”. Uma lista completa de todas as palavras-chave e blocos que 
podem ser especificados em um arquivo de dados é encontrada em http://
www.mohid.com/MembersArea/KeyWords.htm. Na área de download do 
site do MOHID está disponível, também, um conjunto de arquivos de 
dados de amostra. 

Para alterar a forma como os arquivos de dados dos módulos são 
abertos, selecione Tools -> Options -> Data Files/Tools no menu principal 
da MOHID GUI.

Figura 2-8: Captura da tela da área de trabalho do usuário depois de abrir um arquivo de 
dados de um módulo
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2.3.5 Copiando arquivos de dados entre as execuções

A MOHID GUI permite copiar arquivos de dados dos módulos entre 
as execuções, de maneira muito similar à que é feita pelo “Windows 
Explorer”. Para copiar arquivos de dados dos módulos, é necessário 
primeiro selecionar a execução de origem na árvore e, depois, os arquivos 
de dados dos módulos desejados na exibição em lista. Pressionando a 
tecla Ctrl, o usuário pode selecionar vários arquivos. Depois de selecionar 
os arquivos, o usuário deve escolher Edit -> Copy do menu principal 
da MOHID GUI. O próximo passo é selecionar a execução que será o 
destino dos arquivos e selecionar Edit -> Paste no menu principal da 
MOHID GUI. Observe que as teclas de atalho para copiar (Control+C) e 
colar (Control+V) também estão disponíveis. Se o usuário copia o arquivo 
de dados do módulo “Model”, a definição dos módulos associados à 
execução também é copiada. Lembre-se desse recurso e reedite as 
propriedades de Run para redefinir os módulos a serem utilizados.

2.3.6 Executando os Programas Numéricos

Depois de configurar todos os arquivos de dados dos módulos, é 
possível iniciar os programas numéricos da MOHID GUI, selecionando-
se Tools -> Launch Mohid do menu principal da MOHID GUI. Uma caixa 
de diálogo, como mostrado na figura 2-9, aparece. No lado esquerdo da 
caixa de diálogo aparece uma cópia da exibição em árvore que também 
pode ser encontrada no lado esquerdo da janela principal da MOHID GUI. 
Ao marcar as caixas de seleção ao lado dos nós da árvore, o usuário pode 
selecionar os runs a serem executados. Várias execuções podem ser 
selecionadas ao mesmo tempo, elas serão executadas em sequência. 
Execuções de diferentes simulações podem ser selecionadas. No lado 
direito da caixa de diálogo, aparecem algumas opções que controlam a 
forma como o run é executado. Caso o usuário queira executar programas 
numéricos, a opção “Run Mohid” deve ser selecionada. Neste caso, a 
opção “Create Nomfichs” também deve ser selecionada. Outras opções 
são:

• DTLog – escreve o intervalo de tempo modelo para um arquivo 
(relevante apenas se o modelo é executado com intervalos de tempo 
variáveis);

• OutWatch – monitora o desempenho interno da CPU enquanto 
o programa numérico é executado e gera um arquivo log no final da 
execução;

• Output – pode tanto ir para a tela do DOS como pode ser redirecionado 
para um arquivo;

• MPI – esta opção pode ser usada se o usuário deseja executar 
modelos e submodelos distribuídos em uma rede;
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• Launch after OK – esta opção inicia o arquivo de lote que começará 
todas as execuções selecionadas imediatamente após o fechamento das 
caixas de diálogo;

• Batch File – o nome do arquivo de lote;
• Priority – a prioridade no sistema “Gerenciador de tarefas”.

Figura 2-9: Caixa de diálogo para iniciar os programas numéricos

Se a opção “Launch after OK” foi selecionada, imediatamente após 
o fechamento da caixa de diálogo, uma janela DOS como mostrado na 
figura 2-10 deve aparecer. Várias mensagens serão exibidas durante a 
fase de construção do modelo numérico, as quais informam ao usuário 
as opções de computação mais importantes. 
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Figura 2-10: Programa numérico do MOHID durante a fase de construção

Quando o programa numérico passou por toda a fase de construção, 
uma mensagem dizendo “Running MOHID, please wait...” aparecerá. 
Aproximadamente 60 segundos depois dessa mensagem, e deste ponto 
em diante, a cada 60 segundos, uma mensagem aparecerá na janela de 
DOS informando o usuário sobre (veja a Figura 2-11):

• “Time Instant” – o instante de tempo que o modelo numérico está 
simulando naquele momento;

• “Elapsed CPU Time” – o tempo de processamento numérico 
necessário até aquele momento;

• “Remaining” – o tempo de processamento restante até o final da 
execução;

• “Coefficient CPU / Model” – o coeficiente entre o tempo de 
processamento necessário até aquele momento e o intervalo de tempo 
simulado até então;

• “Seconds per iteration” – o tempo gasto para completar um ciclo de 
execução;

• “System time” – o tempo real do sistema;
• “End of the run” – a hora prevista para o final da execução.

Figura 2-11: Programa numérico do MOHID durante o ciclo de execução
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Durante o processo de inicialização dos programas numéricos, um 
conjunto de operações de entrada e saída será realizado:

• Se a opção “Create Nomfichs” estiver ativada, para cada execução 
selecionada, um arquivo de dados no subdiretório “data” será criado. 
Esse arquivo contém links que indicam aos modelos numéricos onde 
encontrar os arquivos de dados dos módulos e onde colocar os arquivos 
de dados de saída. Cada execução tem seu próprio “Nomfich” localizado 
no subdiretório “data” (o nome de cada arquivo “Nomfich” será “Nomfich_
ID.dat”, onde ID representa o ID da execução);

• Imediatamente antes de começar o programa numérico do MOHID, o 
arquivo de lote copiará o arquivo “Nomfich_ID.dat” do run a ser executado 
dentro do subdiretório “exe”, alterando seu nome para “nomfich.dat”. 
Nesse diretório, os modelos numéricos do MOHID sempre esperam um 
arquivo “Nomfich.dat”;

• A MOHID GUI cria, para cada operação a ser executada, um 
subdiretório dentro do subdiretório “res”. Esses subdiretórios serão 
chamados “RunID”, onde o ID é substituído pela identificação da execução. 
Séries temporais produzidas por modelos numéricos do MOHID serão 
colocadas nesses subdiretórios.

• Durante a execução do run, no subdiretório “exe”, dois arquivos serão 
criados: (i) um arquivo chamado “ErrorAndMessages.log” que contém 
mensagens de advertência produzidas pelos modelos numéricos do 
MOHID e (ii) um arquivo chamado “UsedKeyWords.dat” que contém uma 
lista de todas as palavras-chave lidas pelo modelo numérico durante a 
fase de construção.

No final da execução de um programa numérico, a janela do DOS 
deve ser semelhante ao mostrado na Figura 2-12. Algumas informações 
relacionadas ao tempo total de processamento são exibidas.

Figura 2-12: Programa numérico do MOHID após uma execução bem-sucedida
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2.3.7 Excluindo Simulações e Execuções

Para excluir simulações ou execuções, o usuário tem que selecionar 
a simulação (ou execução) que deseja excluir, na exibição em árvore e 
selecionar Edit -> Delete do menu principal da MOHID GUI. A simulação 
(ou execução) selecionada e todas as simulações (ou execuções) 
relacionadas a ela serão excluídas. Uma caixa de diálogo (Figura 2-13) 
aparecerá para que o usuário confirme a exclusão da(s) execução(ões).

Figura 2-13: Caixa de diálogo para confirmar a exclusão de um 
conjunto de execuções

2.3.8 Alterando para o modo pós-processamento

Depois de uma execução bem-sucedida, é possível alterar a MOHID 
GUI do modo de pré-processamento para o de pós-processamento, 
selecionando-se Mode -> Post Processing do menu principal da MOHID 
GUI. No modo pós-processamento, a exibição em lista da janela principal 
da MOHID GUI mostrará arquivos de resultados produzidos pelos modelos 
numéricos do MOHID. No topo da exibição em lista, os arquivos HDF 
serão listados seguidos por séries temporais produzidos pelo modelo. 
Com um clique duplo em qualquer arquivo HDF, o MOHID Post vai iniciar 
e abrir o arquivo selecionado. Um clique duplo em um segundo arquivo 
HDF, vai adicioná-lo ao MOHID Post. Um duplo clique em qualquer série 
temporal iniciará o MOHID Time Series Editor.
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Figura 2-14: A MOHID GUI em Modo Pós-processamento
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MOHID GIS

3.1 Introdução

O MOHID GIS é um sistema de informação geográfica que gerencia 
dados variáveis de espaço e tempo requeridos ou produzidos pelos 
programas numéricos do MOHID. Ele permite carregar e visualizar dados 
armazenados em diferentes formatos:

• MOHID Internal Data Files – arquivos que contenham informações 
geográficas como pontos, linhas, polígonos, malhas, etc. formatados da 
maneira adequada. Todos esses arquivos estão no formato ASCII;

• ESRI Shape Files – arquivos que são utilizados pelo software ESRI 
ArcView;

• MOHID HDF 5 Files – arquivos escritos em HDF5 padrão, mas com 
alguns conjuntos de dados especiais que contêm informações geográficas 
e temporais.

A janela principal do MOHID GIS existe um menu principal e uma 
área de cliente onde as janelas-filho estão localizadas. Uma janela-filho 
é dividida em duas áreas: (i) uma exibição em lista acoplada à borda 
esquerda da janela e (ii) a área de exibição, que ocupa o restante da 
janela, onde as informações são exibidas.

3
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Figura 3-1: Janela principal do MOHID GIS

O MOHID GIS organiza as informações dividindo-as em três unidades: 
(i) projetos “projects”, (ii) vistas “views” e (iii) itens de dados “data 
items”.

3.2 Organização Interna

Um projeto é a unidade de mais alto nível e agrupa uma ou mais 
vistas. Apenas um projeto por vez pode ser aberto pelo MOHID GIS. 
Cada um dos projetos tem um arquivo de projeto associado, onde todas 
as suas informações estão armazenadas.

Uma vista corresponde a uma janela-filho.  Itens de dados são 
acrescentados a uma janela-filho e exibidos por ela. Um número infinito 
de vistas pode ser criado em um projeto, sendo sua única limitação os 
recursos computacionais do usuário. Há diferentes tipos de vistas:

• “XY View” – exibe informações como “seen from the top” (vista de 
cima) ou, em outras palavras, como um plano XY;

• “3D View” – exibe informações em um espaço tridimensional. 
Um item de dados é um conjunto de entidades de dados específicos. 

Os itens de dados podem ser de diferentes tipos:
• “Points” – um conjunto de pontos XYZ com nome opcional, 

armazenado no formato de dados internos do MOHID;
• “Polygons” – um conjunto de polígonos, sem furos, armazenado no 

formato de dados internos do MOHID;
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• “Lines” – um conjunto de linhas, armazenado no formato de dados 
internos do MOHID;

• “Grids” – um arquivo que define uma malha, como usado pelos 
programas numéricos do MOHID;

• “Grid Data” – um arquivo que define uma malha e os respectivos 
valores da célula central, como usado pelos programas numéricos do 
MOHID;

• “Background Image” – um arquivo ASCII que indica o caminho para 
uma imagem a ser exibida e suas configurações de georreferência; 

• “Drainage Network” – um arquivo que define uma rede de drenagem, 
como usado pelos programas numéricos do MOHID;

• “River Cross Sections” – um arquivo que define as seções transversais 
do rio, como usado pelos programas numéricos do MOHID;

• “Time Series” – um arquivo que contém uma série temporal, como 
usado pelos programas numéricos do MOHID;

• “HDF5 File” – um arquivo escrito em HDF5, mas com alguns conjuntos 
de dados especiais que contêm informações geográficas e temporais;

• “ESRI Shapefile” – qualquer ‘‘ESRI Shapefile’’ válido, contendo 
pontos, multipontos, linhas, multilinhas, polígonos e multipolígonos;

Os nove primeiros itens de dados são arquivos escritos no formato 
chamado Dados Internos do MOHID, enquanto que os arquivos HDF5 e 
os ESRI Shapefiles são escritos em outros formatos.

3.3 Passo a passo

O capítulo descreve o passo a passo de como utilizar o MOHID GIS 
para criar um novo projeto, criar vistas e acrescentar itens de dados, alterar 
as configurações de exibição, acrescentar legendas, salvar imagens, 
animar os resultados dos modelos e como utilizar as ferramentas para 
pré-processar os dados para os modelos numéricos do MOHID.

3.3.1 Criando um projeto

Para criar um novo projeto, o MOHID GIS deve ser iniciado 
selecionando-se Start -> Programs -> Mohid -> MOHID GIS. Uma janela 
vazia do MOHID GIS aparecerá (Figura 3-2).
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Figura 3-2: Uma janela vazia do MOHID GIS

Um novo projeto pode ser criado selecionando-se File -> New -> 
Project... no menu principal do MOHID GIS. Uma caixa de diálogo 
aparecerá onde o usuário deve especificar a localização e nome do 
arquivo do projeto (a extensão deve ser *.mgp). Depois de fechar a caixa 
de diálogo, o MOHID GIS acrescenta automaticamente uma nova vista 
XY ao projeto e o menu principal se torna ativo.

3.3.2 Acrescentando uma vista

Para acrescentar mais vistas ao projeto, selecione File -> New -> XY 
View... ou File -> New -> 3D View... no menu principal do MOHID GIS.

3.3.3 Acrescentando itens de dados

Para acrescentar um novo item de dados a uma vista, o usuário deve 
ativar primeiro a vista na qual o novo item de dados será acrescentado. 
Em seguida, selecionando-se Data Items -> Add... no menu principal do 
MOHID GIS, uma caixa de diálogo aparece, permitindo especificar o tipo e 
a localização do item de dados a ser acrescentado, como mostra a figura 
3-3. Vários itens de dados do mesmo tipo podem ser acrescentados ao 
mesmo tempo.
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Figura 3-3: Acrescentando um item de dados existente

Depois de acrescentar um item de dados existente, um ícone do item 
de dados recém-acrescentado será adicionado ao final da exibição em 
lista e a janela principal do MOHID GIS poderá ser vista como na figura 
3-4.

Figura 3-4: Janela principal do MOHID GIS com alguns itens de dados
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3.3.4 Aparência dos Itens de dados

Os itens de dados aparecem, em vistas XY “XY Views”, como camadas. 
O item de dados de mais alto nível da exibição em lista representa a 
camada superior enquanto o último item de dados representa a inferior. 
É possível alterar a ordem dos itens de dados, arrastando-os para cima 
e para baixo com o mouse. Também é possível ativar ou desativar cada 
item de dados, alternando-se a marcação na caixa de seleção ao lado 
dos ícones dos itens de dados na exibição em lista.

A forma como os itens de dados são exibidos depende de várias 
configurações. As configurações dependem do tipo dos itens de dados. 
As configurações podem ser acessadas selecionando-se um item de 
dados na exibição em lista e, depois, apontando-se para Data Items -> 
Properties no menu principal do MOHID GIS (a tecla de atalho é F4 e 
com um clique no botão direito do mouse, aparece um menu de atalho). 
A figura 3-5 mostra as propriedades de um item de dados de pontos XYZ 
“XYZ Points”. Comuns a todos os itens de dados são as informações 
armazenadas nos grupos “General” e “Color”. O primeiro grupo mostra 
o caminho para o arquivo do item de dados e informações sobre sua 
posição e sua extensão no plano XY. O segundo grupo permite ao usuário 
escolher como “colorir” itens de dados e se ele deseja exibir a escala de 
cor na área de exibição.

Para alguns itens de dados, é necessário especificar o tamanho (por 
exemplo: o tamanho dos pontos, a largura das linhas). Se o tamanho 
não for fornecido em pixels, então é necessário levar em conta que os 
valores especificados dependem do tipo de coordenadas que o usuário 
está utilizando. Caso o usuário esteja utilizando coordenadas métricas, 
os valores dos tamanhos estarão em metros, caso ele esteja utilizando 
coordenadas geográficas, os valores dos tamanhos estarão em graus 
decimais.

Figura 3-5: Propriedades de um item de dados XYZ
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As propriedades de cor dos itens de dados podem ser acessadas 
por meio do botão “Settings...” no grupo “Color”. A coloração é baseada 
em um valor, o valor base de cor. Os valores base de cor disponíveis 
dependem do tipo de item de dados (por exemplo: Z para pontos, ID para 
polígonos). Caso haja mais de um valor base de cor disponível, ele pode 
ser escolhido na caixa de listagem suspensa chamada “Based On”.

Ao clicar no botão “Settings” no grupo “Color”, uma janela de diálogo, 
como mostrado na figura 3-6, aparecerá. Essa caixa de diálogo permite 
ao usuário escolher as cores para os itens de dados de diferentes 
maneiras:

• constant – todas as entidades de itens de dados são coloridas com 
uma cor única, desde que os valores do valor base de cor estejam dentro 
do intervalo especificado no grupo “Limits”. Caso o valor esteja abaixo 
do limite, a cor especificada na área ‘abaixo do limite’ é aplicada. Caso o 
valor exceda o valor máximo, a cor do ‘acima do limite’ é aplicada;

• gradual – todas as entidades de itens de dados são coloridas baseadas 
em uma escala gradual de cor. As cores são obtidas por interpolação 
linear ou logarítmica com base nos limites do grupo “Limits” e do valor 
base de cor. Para as entidades com valores fora dos limites, aplicam-se 
as mesmas regras para a coloração constante;

• classified – todas as entidades de itens de dados são coloridas com 
base na classificação de variação de cores, definida pelo usuário. Para 
entidades com valores fora dos limites, aplicam-se as mesmas regras 
para uma coloração constante.

Figura 3-6: Diálogo da configuração de cores
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3.3.5 Criando novos itens de dados

O MOHID GIS permite criar alguns itens de dados a partir do zero. Ao 
selecionar Data Items -> New... no menu principal do MOHID GIS, uma 
janela de diálogo, como mostra a figura 3-7, aparece. Aqui é possível 
escolher o tipo de item de dados a ser criado e onde o respectivo arquivo 
estará localizado.

Figura 3-7: Acrescentando um novo item de dados

3.3.6 Removendo itens de dados

Ao selecionar um ou mais itens de dados da exibição em lista e 
selecionando-se Data Items -> Remove do menu principal do MOHID 
GIS, os itens de dados serão removidos da lista.

3.3.7 Acrescentando entidades de dados específicos

É possível acrescentar entidades de dados específicos aos itens de 
dados dos tipos XYZ, linhas e polígonos. Primeiramente o usuário precisa 
selecionar na exibição em lista o item de dados ao qual acrescentará as 
entidades. O próximo passo é selecionar Tools -> Add -> Add Points / 
Lines / Polygons no menu principal do MOHID GIS.

Os pontos são acrescentados com o botão esquerdo do mouse sobre 
a área de exibição. Para parar de acrescentar pontos, o botão direito do 
mouse deve ser pressionado.

Os vértices de linhas são acrescentados com o botão esquerdo do 
mouse sobre a área de exibição. Para finalizar a linha, o botão direito do 
mouse deve ser pressionado.

Os vértices de polígonos são acrescentados com o botão esquerdo do 
mouse sobre a área de exibição. Para fechar o polígono o botão direito 
do mouse deve ser pressionado.
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3.3.8 Carregando itens de dados HDF 5

Itens de dados HDF 5 são um caso especial de itens de dados, 
porque o usuário tem que executar vários passos antes de visualizá-
los. O MOHID GIS exige que o arquivo HDF 5 contenha as informações 
geográficas e temporais sobre o conjunto de dados que será carregado. 
Todos os arquivos HDF 5 produzidos pelos programas numéricos do 
MOHID contêm essas informações. Para exibir as informações contidas 
em um arquivo HDF 5 é necessário o seguinte:

1. Acrescentar um arquivo HDF 5 como descrito em Acrescentando 
itens de dados;

2. Selecionar o novo item de dados acrescentado da exibição em 
lista e acessar suas propriedades (como descrito em Aparência dos 
itens de dados). Uma janela de diálogo, como mostrado na figura 3-8, 
aparecerá;

3. Pressionar o botão “Data Selection”, localizado no lado direito 
da janela, para selecionar os dados do arquivo HDF 5  que deve ser 
representado;

Figura 3-8: Janela de propriedades de um item de dados HDF 5

4. Uma janela, como mostrado na figura 3-9, aparece. Esta janela 
permite ao usuário selecionar como cada tipo de informação deve ser 
representado e quais são as informações geográficas e temporais 
associadas aos conjuntos de dados. As informações a serem selecionadas 
são divididas em informação obrigatória e informação opcional. A 
informação obrigatória está relacionada à referência de mapeamento, 
geográfica e temporal dos conjuntos de dados e a informação opcional é o 
próprio conjunto de dados. As informações são selecionadas, arrastando-
se itens da exibição em árvore do HDF 5 localizada no lado esquerdo da 
janela de diálogo para a respectiva exibição em lista no lado direito da 
janela de diálogo (ou utilizando o comando “Action” do menu principal);



MOHID: interfaces gráficas do usuário: manual do usuário

36

Figura 3-9: Janela de seleção de dados HDF 5

5. As informações geográficas sobre o conjunto de dados são 
obrigatórias e devem ser ou conjunto de dados Conexão X/Y “Connection 
X/Y” ou Latitude/Longitude, dependendo das coordenadas utilizadas 
na área de exibição do MOHID GIS. As informações geográficas são 
acrescentadas, selecionando-se a exibição em lista da malha “Grid”. 
Depois de acrescentar as informações geográficas, a exibição em lista 
da malha “Grid” deve ser parecida com o mostrado na figura 3-10;

Figura 3-10: Janela de seleção de dados HDF 5 depois de acrescentadas informações 
geográficas
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6. As informações de mapeamento indicam ao MOHID GIS se um 
determinado ponto da malha deve ser representado ou não (por exemplo: 
pontos de água contra pontos de terra). As informações de mapeamento 
armazenadas em arquivos HDF 5 produzidas pelos programas 
numéricos do MOHID são: (i) pontos de água “Waterpoints”, pontos em 
aberto “OpenPoints” e pontos de bacia “BasinPoints”. As informações de 
mapeamento são acrescentadas na exibição em lista do mapeamento 
“mapping”. Depois de acrescentar as informações de mapeamento, a 
exibição em lista das informações de mapeamento deve ser semelhante 
à mostrada na figura 3-11;

Figura 3-11: Janela de seleção de dados HDF 5 depois de acrescentadas informações de 
mapeamento

7. A terceira informação obrigatória é a informação temporal. As 
informações de tempo são acrescentadas à exibição em lista do tempo 
do mesmo modo que as informações geográficas e de mapeamento são 
acrescentadas.

8. Selecionando-se Settings -> General..., o usuário tem acesso à 
janela de diálogo de configurações gerais, que permite escolher entre 
várias configurações (figura 3-12). Aqui o usuário pode escolher qual 
plano deve ser importado de uma matriz 3D e como o botão “Quick 
Add” (Adicionar rapidamente) da barra do menu se comporta. Esse 
botão permite acrescentar com um único clique todas as informações 
obrigatórias (temporais, geográficas, e de mapeamento).
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Figura 3-12: Janela de seleção de dados de configurações gerais

9. As informações opcionais indicam ao MOHID GIS o que realmente 
deve ser representado. Existem quatro maneiras de representar as 
informações: (i) matriz de cor “color matrix”, (ii) linhas de contorno “contour 
lines”, (iii) campo vetorial “vector plot” e (iv) partículas lagrangianas 
“lagrangian particles”. As informações acrescentadas ao (i) e ao (ii) 
devem ser do tipo matrizes 2D ou 3D (por exemplo: o módulo de fluxo, a 
concentração de nitrato, volume de água na superfície). As informações 
acrescentadas ao (iii) devem ter um componente X e um Y (por exemplo: a 
velocidade do fluxo, a velocidade do vento). As informações acrescentadas 
ao (iv) são aquelas produzidas pelo módulo lagrangiano. As informações 
opcionais têm sua origem geralmente na pasta “Results” (resultados) da 
exibição em árvore do HDF 5. A figura 3-13 mostra um exemplo da janela 
de seleção de dados depois do acréscimo de informações do campo 
vetorial.
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Figura 3-13: Janela de seleção de dados depois de acrescentadas informações do Campo 
vetorial

10. Ao escolher Close Return da janela principal do menu Data 
Selections, todos os dados selecionados serão carregados e a janela se 
fechará;

11. Na janela de propriedades do item de dados HDF 5, agora é possível 
estabelecer as configurações relativas à representação do conjunto 
de dados selecionados. Somente as configurações dos conjuntos de 
dados que foram carregados estão habilitadas. A figura 3-14 mostra um 
exemplo disso. As configurações para as cores são as mesmas dos itens 
de dados da malha, a largura das linhas de contorno é dada em unidades 
exibidas na tela (não em pixel), a dimensão do vetor também é atribuída 
em unidades exibidas na tela (uma escala de 1000 significa que um vetor 
de 1m/s será representado por uma seta de 1000 unidades exibidas na 
tela).

Figura 3-14: Janela de propriedades de um item de dados HDF 5  após a  seleção de 
dados



MOHID: interfaces gráficas do usuário: manual do usuário

40

Após o carregamento de dados dos arquivos HDF 5, o usuário pode 
percorrer os conjuntos de dados carregados pelas animações exibidas na 
tela, utilizando o programa de animação (veja Usando o ‘‘Animators’’).

3.3.9 Dando zoom e obtendo uma visão panorâmica

Vários métodos estão disponíveis em Exibições XY “XY Views” para 
dar zoom e obter uma visão panorâmica da imagem atual. Do menu 
principal do MOHID GIS as opções disponíveis são as seguintes:

• “Zoom Rectangle” – o display dará zoom na área retangular 
selecionada com o mouse;

• “Zoom Checked Items” – o display dará zoom no menor retângulo 
que contenha todos os itens marcados na exibição em lista (esta opção 
também é acessível por meio de um menu pop-up da exibição em lista);

• “Zoom Selected Items” – o display dará zoom no menor retângulo que 
contenha todos os itens selecionados na exibição em lista (esta opção 
também é acessível por meio de um menu pop-up da exibição em lista);

• “Zoom Extended” – o display dará zoom no menor retângulo que 
contenha todos os itens da exibição em lista;

• “Zoom Out” – a área da exibição é distanciada em 10%, usando seu 
ponto central como referência;

• “Zoom In” – a área da exibição é aproximada em 10%, usando seu 
ponto central como referência;

• “Pan” – dá uma visão panorâmica da imagem com o mouse;
Ao selecionar Action -> None interrompe-se qualquer ação previamente 

selecionada. É também possível aproximar e afastar a imagem usando 
a rolagem do mouse.

3.3.10 Obtendo informações

Para obter informações sobre uma determinada área, o usuário tem 
a possibilidade de selecionar Action -> Info -> Info Area / point do menu 
principal do MOHID GIS. Depois de selecionar a área desejada, uma 
janela como a da figura 3-15 exibirá informações sobre os itens de dados 
da área selecionada.
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Figura 3-15: Janela de diálogo que exibe as informações encontradas na 
área selecionada

3.3.11 Acrescentando legendas

Vários tipos de legendas podem ser acrescentados à exibição na tela. 
Essas legendas são: (i) um texto de legenda na parte inferior da tela, 
(ii) o indicador do norte, (iii) uma escala horizontal, (iv) um indicador de 
precipitação e (v) escalas de cores para cada item de dados.

Um texto de legenda na parte inferior da área de exibição pode ser 
acrescentado selecionando-se OpenGL -> Bottom Legend... do menu 
principal do MOHID GIS. Uma janela de diálogo, como mostrado na figura 
3-16, aparece. O texto da legenda (duas linhas) bem como o tamanho e 
o tipo da fonte podem ser escolhidos. Para o texto da legenda aparecer 
na área de exibição, a caixa de seleção “Show” deve estar marcada.  Há 
uma opção para visualizar o tempo. O tempo indicado dependerá do 
tempo/índice da animação atual (veja Usando o ‘‘Animators’’).
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Figura 3-16: Configuração do texto da legenda da parte inferior da tela

Depois de fechar a janela de diálogo do texto da legenda, o texto da 
legenda aparecerá como mostrado na parte inferior da área de exibição 
(veja a figura 3-17).

Figura 3-17: Vista da legenda em exibição na parte inferior da tela

Um indicador do norte pode ser acrescentado à área de exibição 
selecionando-se OpenGL -> North Indicator... no menu principal do 
MOHID GIS. Uma janela de diálogo, como mostra a figura 3-18, aparece. 
A localização (em pixels), no canto inferior esquerdo, do Indicador do 
Norte, assim como sua largura e sua altura, devem ser fornecidas pelo 
usuário. Dois tipos de indicadores do norte estão disponíveis.
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Figura 3-18: Configurações do Indicador do Norte

Uma escala horizontal, que indica a distância, pode ser acrescentada 
à área de exibição, selecionando-se OpenGL -> Horizontal Scale... do  
menu principal do MOHID GIS. Uma janela de diálogo, como mostrada 
na figura 3-19, aparece. Da mesma forma que para o Indicador do Norte, 
o usuário tem que especificar a localização da escala. As unidades da 
escala podem estar em metros ou quilômetros.

Figura 3-19: Configurações da Escala Horizontal
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3.3.12 Salvando imagens

É sempre possível salvar a imagem exibida na tela em diferentes 
formatos de arquivos. Selecionando-se Data Items -> Save Image do 
menu principal do MOHID GIS, uma janela de diálogo, como mostrado 
na figura 3-20, aparece. Nessa janela o usuário pode escolher o formato 
e o destino do arquivo.

Figura 3-20: Salvando a imagem atual da tela em um arquivo

3.3.13 Usando o “Animators”

O “Animators” permite animar, exibir a imagem, percorrer os conjuntos 
de dados carregados a partir de arquivos HDF 5 e séries temporais. O 
MOHID GIS inclui dois tipos de animações: (i) uma animação baseada no 
índice e (ii) uma animação baseada no tempo. As animações baseadas 
em índice utilizam os índices dos conjuntos de dados carregados, e as 
animações baseadas no tempo se baseiam no intervalo de tempo ou 
passo de tempo definido pelo usuário. Ao escolher “OpenGL -> Animator 
-> Index Based Animator” no menu principal do MOHID GIS, o usuário 
tem acesso ao primeiro animador (escolha “Time Based Animator” no 
mesmo menu para acessar o segundo). O animador aparece abaixo da 
exibição em lista em uma janela-filho do MOHID GIS, como mostrado 
na figura 3-21. Os campos “Start” e “End” indicam os limites atuais dos 
índices de todos os itens de dados HDF 5 carregados, os botões  “->” e 
“<-’’ podem ser usados, respectivamente, para mover a imagem para trás 
e para frente, o botão “Render All” reproduz todos os índices novamente e 
“Save All...” pode ser usado para salvar todas as imagens em uma pasta 
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Figura 3-21: Animador baseado em índices

definida pelo usuário. A animação baseada no tempo funciona de uma 
maneira muito similar. O “Animators” pode ser ocultado, selecionando-se 
“OpenGL -> Animator -> Hide” no menu principal do MOHID GIS.

3.4 Ferramentas 

Há um conjunto de ferramentas disponíveis no menu principal do 
MOHID GIS (submenu Tool). As ferramentas são projetadas para criar 
arquivos de entrada de dados para os programas numéricos do MOHID 
e são descritas a seguir.

3.4.1 Criando um terreno digital 

Selecionando-se Tools -> Create Digital Terrain do menu principal do 
MOHID GIS, o usuário tem a possibilidade de criar um arquivo de dados 
da malha (Grid Data) para ser usado como entrada de batimetria para o 
MOHID Water ou como entrada de topografia para o MOHID Land (ou 
qualquer outro arquivo de dados da malha que seja necessário para os 
modelos numéricos). Uma janela de diálogo, como mostrado na figura 
3-22, aparecerá. Essa janela é uma interface para iniciar o programa 
numérico Criador de Terreno Digital do MOHID “MOHID Digital Terrain 
Creator”.

No lado direito da janela, o usuário deve especificar qual malha e 
conjuntos de dados XYZ serão utilizados para criar o terreno digital. 
Opcionalmente, um conjunto de polígonos pode ser especificado, 
definindo onde áreas “no compute” (não computar) estão (por exemplo: 
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Figura 3-22: Janela para criar um terreno digital

pontos de terra para o MOHID Water). O arquivo de destino dos dados da 
malha deve ser selecionado em “Digital Terrain File”. Há um conjunto de 
opções disponíveis que controlam a maneira como o Criador de Terreno 
Digital do MOHID irá se comportar.

Essas opções podem ser acessadas pelas abas “Options” Opções;   
“Advanced Options” Opções avançadas e “Overlapping” Sobreposição 
(veja a figura 3-23). Na aba “Option” o usuário pode escolher que tipo 
interpolação usar.

Depois de definir todas as opções, o usuário tem que pressionar o botão 
“Run” no lado esquerdo da janela para executar o Criador de Terreno 
Digital do MOHID. A saída desse programa numérico é redirecionada 
para a janela localizada no canto superior esquerdo da Figura 3-22.

Após o fechamento da caixa de diálogo, o recém-criado arquivo 
de dados da malha será automaticamente carregado para exibição no 
MOHID GIS.
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Figura 3-23: Opções para controlar a criação do terreno digital

3.4.2 Removendo depressões 

Para tornar os arquivos de dados topográficos da malha apropriados 
para o MOHID Land, eles devem ser “livres de depressões”. Selecionando-
se Tools -> Remove Depression... no menu principal do MOHID GIS, uma 
caixa de diálogo, como mostrado na figura 3-24, aparece. Essa janela é 
uma interface para iniciar o programa numérico MOHID Basin Delineator 
(Delineador de Bacias Hidrográficas do MOHID).

No lado esquerdo da janela, o usuário deve selecionar o item de dados 
da malha do qual as depressões devem ser removidas, a inclinação 
mínima a considerar e o novo arquivo de dados da malha a ser criado.

Após a configuração de todas as opções, o usuário deve pressionar 
o botão “Run” no lado esquerdo da janela para executar o Delineador 
de Bacias Hidrográficas do MOHID.  A saída desse programa numérico 
é redirecionada para a janela localizada no canto superior esquerdo da 
Figura 3-24.

Após o fechamento da caixa diálogo, o recém-criado arquivo de dados 
da malha será automaticamente carregado para exibição no MOHID 
GIS.
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Figura 3-24: Janela para remover depressões

3.4.3 Delineando bacias hidrográficas 

O MOHID Land pode receber uma Drainage Network (rede de 
drenagem) e um delineamento de uma bacia. Selecionando-se Tools -> 
Delineate Basin... no menu principal do MOHID GIS, uma caixa de diálogo, 
como mostrado na Figura 3-25, aparece. Essa janela é outra interface 
para iniciar o programa numérico Delineador de Bacias Hidrográficas do 
MOHID.

A partir dessa janela o usuário tem a possibilidade de criar itens de 
dados com informações sobre (i) delineamento da bacia, (ii) rede de 
drenagem, (iii) direção de drenagem, (iv) área drenada a montante e (v) 
inclinação da célula. O primeiro item de dados é um polígono, o segundo 
é uma rede de drenagem e os últimos três são os itens de dados da 
malha. A topografia utilizada como base de dados deve ser especificada 
na caixa de listagem no lado superior direito da janela. O usuário tem 
como opção especificar a localização dos reservatórios.

A área Threshold (Limite) é um parâmetro que é utilizado pelo 
Delineador de Bacias Hidrográficas do MOHID como área mínima 
drenada a partir da qual os canais de rede de drenagem começam a 
existir. Caso o usuário queira delinear uma bacia, a célula da malha da 
saída (do arquivo topográfico) deve ser especificada.

Depois de definir todas as opções, pressione o botão “Run” no lado 
esquerdo da janela para executar o Delineador de Bacias Hidrográficas 
do MOHID.  A saída desse programa numérico é redirecionada para a 
janela localizada no canto superior esquerdo da Figura 3-25.

Após o fechamento da caixa de diálogo, os itens de dados recém-
criados serão automaticamente carregados para exibição no MOHID 
GIS.
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Figura 3-25: Janela para delinear uma bacia hidrográfica

3.4.4 Seções transversais automáticas “Auto Cross Sections”

As seções transversais das redes de drenagem precisam ser definidas 
para que o MOHID Land (ou o MOHID River Network) possa ser 
executado. Isso pode ser feito automaticamente, selecionando-se Tools 
-> Auto Cross Sections... no menu principal do MOHID GIS. Uma caixa 
de diálogo, como mostrado na figura 3-26, aparece. Essa janela permite 
interpolar seções transversais trapezoidais em função da área drenada 
a montante. No topo da janela, o usuário tem que escolher a rede de 
drenagem a ser processada e, abaixo, o usuário deve especificar um 
conjunto de seções transversais pré-definidas para determinadas áreas 
drenadas a montante.
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Figura 3-26: Janela para interpolar seções transversais

Ao clicar no botão Add... ou no  botão Edit..., o Cross Sections Editor 
(Editor de Seções Transversais) incorporado ao MOHID GIS será aberto 
(Figura 3-27). Aqui é possível definir as características de uma seção 
transversal. 

Depois de definir um conjunto de seções transversais (pelo menos 
duas, cobrindo todas as áreas drenadas), escolha a opção para interpolar 
as seções transversais para toda a rede de drenagem utilizando a 
interpolação linear ou a logarítmica.
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Figura 3-27: Editor de seções transversais do MOHID GIS

3.4.5 Operador de dados da malha “Grid Data Operator”

Selecionando-se Tools -> Grid Data Operator no menu principal 
do MOHID GIS, o usuário tem acesso ao Operador de dados da 
malha incorporado ao MOHID GIS. Essa ferramenta permite executar 
operações básicas de itens de dados da malha existentes (Figura 3-28). 
As operações possíveis são:

• igualar um item de dados da malha a um valor constante;
• somar, subtrair, multiplicar ou dividir um item de dados da malha por 

um valor constante;
• igualar, somar, subtrair ou multiplicar item de dados da malha 1 com/

por item de dados da malha 2;
• realizar uma interpolação linear no item de dados da malha 1 

utilizando o item de dados da malha 2 como valor de “m”.
As operações podem ser restringidas e somente aplicadas em pontos 

da malha (do item de dados da malha 1) que correspondem às restrições 
especificadas em “Constrains” (Restrições).

No lado direito da janela, o usuário pode selecionar a operação 
a executar, e no lado esquerdo, quais itens de dados da malha serão 
usados para as operações. O item de dados da malha que será modificado 
(pressionando o botão “Run”) é sempre o item de dados da malha 1.
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Figura 3-28: Janela do operador de dados da malha

3.4.6 “Shape File” para dados da malha

Selecionando-se Tools -> Shape to Grid Data... do menu principal 
do MOHID GIS, uma janela de diálogo, como mostrado na Figura 3-29, 
aparece. Aqui o usuário tem a possibilidade de converter “Shape Files” 
que contenham polígonos em itens de dados da malha. A origem do 
“Shape File” deve ser selecionada na caixa de listagem no canto superior 
esquerdo da Figura 3-29, e a malha que será usada, na caixa de listagem 
no canto inferior esquerdo da Figura 3-29.

No lado direito aparece uma caixa suspensa que contém todas as 
colunas numéricas da tabela de dados que pertence ao “Shape File” 
selecionado. Na “Table Lookup” (tabela de pesquisa), o usuário tem que 
especificar os valores que devem ser atribuídos às células da malha, 
dependendo do valor numérico encontrado na tabela de dados do “Shape 
File” (por exemplo: na Figura 3-29 todos os pontos da malha cobertos por 
polígonos no Shape File com Soil Texture Class [SLTXCL] 2 – classe de 
textura do solo 2 – receberão um valor de 2.75).

O destino dos arquivos de dados da malha deve ser especificado em 
“Output File...”. Ao pressionar o botão “Run...” o arquivo de dados da 
malha será criado.
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Figura 3-29: Convertendo um Shape File de polígonos em dados da malha

3.4.7 “Shape File” para Pontos XYZ 

Selecionando-se Tools -> Shape to Grid Data... no menu principal 
do MOHID GIS, uma janela de diálogo, como mostrado na Figura 3-30, 
aparece. Há a possibilidade de converter “Shape Files” que contêm 
pontos em pontos XYZ. As colunas de dados utilizadas como Z e o texto 
devem ser selecionados nas caixas suspensas à direita e o destino do 
arquivo XYZ deve ser especificado em “Output File”. Ao pressionar o 
botão “Run” o arquivo de pontos XYZ será criado.

Figura 3-30: Convertendo um Shape File que contém pontos em pontos XYZ

3.4.8 Exportando para “Shape File”

Selecionando-se Tools -> Export To Shape File... no menu principal 
do MOHID GIS, uma  janela de diálogo, como mostrado na Figura 3-31, 
aparece. Existe a possibilidade de converter pontos XYZ, polígonos, rede 
de drenagem e linhas em “Shape Files”. Os “Shape Files” serão criados 
na mesma pasta onde os itens de dados originais estão localizados.
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Figura 3-31: Exportando itens de dados para Shape Files

3.4.9 Criando “Caixas”

Os programas numéricos do MOHID utilizam polígonos em forma 
de “caixas” para executar a inicialização ou operações de saída. Essas 
caixas podem ser criadas a partir de dados de polígonos e dados da 
malha, selecionando-se Tools -> Create Boxes do menu principal do 
MOHID GIS. Uma janela de diálogo, como mostrado na Figura 3-32, 
aparece. Para prosseguir, o usuário tem que escolher um dado da malha 
e um dado de polígono. Em “Boxes File”, o destino do arquivo da caixa 
a ser criado é escolhido. Ao clicar OK, o arquivo da caixa será criado e a 
janela de diálogo é fechada.
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Figura 3-32: Criando caixas para os programas numéricos do MOHID

3.4.10 Criando a localização das séries temporais da malha

Os programas numéricos do MOHID utilizam pontos para escrever a 
saída de séries temporais. Selecionando-se Tools -> Create Grid Time 
Series Locations do menu principal do MOHID GIS, o usuário tem a 
possibilidade de criar um arquivo de entrada que indica aos programas 
numéricos do MOHID onde as séries temporais baseadas na malha 
devem ser escritas. Uma janela de diálogo, como mostrado na Figura 
3-33, aparece. Para criar um arquivo de localização das séries temporais, 
o usuário tem que escolher um item de dados do tipo dados da malha 
e um do tipo pontos XYZ nas caixas de listagem.  Em “Location file”, 
o arquivo de destino é especificado. DT Output indica aos programas 
numéricos do MOHID com que intervalo de tempo as séries temporais 
serão escritas. Clicando-se OK, o arquivo de localização das séries 
temporais será criado e a janela de diálogo é fechada.
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Figura 3-33: Criando localizações de séries temporais da malha

3.4.11 Criando a localização das séries temporais dos nós

Selecionando-se Tools -> Create Node Time Series Locations no 
menu principal do MOHID GIS, o usuário tem a possibilidade de criar 
um arquivo de dados de entrada que indica aos programas numéricos 
do MOHID onde as séries temporais baseadas em nós serão escritas. 
Uma janela de diálogo, como mostrado na Figura 3-34, aparece. Para 
criar um arquivo de localização de séries temporais, o usuário tem que 
escolher um item de dados do tipo rede de drenagem e um do tipo pontos 
XYZ nas caixas de listagem. Em “Location file” o arquivo de destino é 
especificado. DT Output indica aos programas numéricos do MOHID com 
qual intervalo de tempo as séries temporais serão escritas. Clicando-se 
OK, o arquivo de localização das séries temporais será criado e a janela 
de diálogo é fechada.
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Figura 3-34: Criando localizações de séries temporais dos nós
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MOHID Postprocessor (Pós-processador do MOHID)

4.1 Introdução

O Pós-processador do MOHID é uma interface gráfica do usuário que 
exibe os dados armazenados em arquivos HDF como animações na tela. 
Essa ferramenta permite visualizar a evolução temporal e a distribuição 
espacial de qualquer propriedade como uma animação contínua. Os 
dados podem ser exibidos de várias formas, tais como, mapas de cores, 
isolinhas, campos vetoriais e partículas (para o modelo Lagrangiano). 
A exibição pode se dar em diferentes vistas: plano XY, plano XZ, plano 
YZ, plano TZ ou cubo 3D. Normalmente o Pós-processador do MOHID 
iniciará diretamente da MOHID GUI, abrindo de modo automático o 
arquivo escolhido pelo usuário (veja a seção 2.3.8 “Alterando para o 
modo pós-processamento”).

Para utilizar o Pós-processador do MOHID, é geralmente necessário 
executar os seguintes passos: 

• abrir um ou mais arquivos HDF (veja a seção 4.3.1 “Abrindo um 
arquivo HDF”);

• selecionar a malha sobre a qual os dados serão representados (veja 
a seção 4.3.2 “Selecionando Informações Geográficas”);

• selecionar os dados para representar (veja a seção 4.3.4 “Selecionando 
as informações para exibir”);

• carregar os dados (veja a seção 4.3.5 “Carregando os dados”);
• ajustar as configurações dos dados (veja a seção 4.4.3 “Configurações 

de imagem”);
• exibir os dados (veja a seção 4.4 “Janela OpenGL”);

4
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Figura 4-1: Janela principal do Pós-processador do MOHID

• salvar as imagens (veja a seção 4.4.4 “Salvando as imagens”).
O Pós-processador do MOHID está escrito em FORTRAN e utiliza o 

OpenGL para exibir os resultados.

4.2 Janela principal

A janela principal do Pós-processador do MOHID (com um arquivo 
aberto) é mostrada na figura 4-1. Esta janela é dividida em três áreas 
principais: (i) vista da Árvore HDF “HDF Tree View”  à esquerda, (ii) 
botões de seleção “Selection Buttons” no centro e (iii) listas de seleção 
“Selection Lists” à direita.

4.2.1 Árvore HDF “HDF Tree”

A Árvore HDF exibe, de forma hierárquica, o conteúdo de um arquivo 
HDF 5. O símbolo  representa um arquivo HDF, o símbolo  um 
grupo de itens HDF e o símbolo  um único item HDF (uma matriz).

4.2.2 Botões de seleção

Os botões de seleção permitem transferir itens de dados selecionados 
da árvore HDF para as Listas de Dados Selecionados. Por exemplo, para 
exibir os módulos de velocidade como um mapa de cores, selecione o 
item HDF na Árvore HDF e, depois, pressione o botão “Color” (o primeiro 
botão dos botões de seleção). A informação passará para as Listas de 
Dados Selecionados. Selecionando-se um grupo de dados, todos os 
itens do grupo passarão para as Listas de Dados Selecionados.
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4.2.3 Listas de Dados Selecionados

As Listas de Dados Selecionados exibem os dados selecionados para 
ser exibidos. Para remover dados de qualquer das listas, selecione os 
itens de dados a serem removidos e escolha Action -> Delete do menu 
principal do Pós-processador do MOHID .

4.3 Selecionando Dados e Tipos de Gráficos

Esta seção descreve como selecionar dados de arquivos HDF 5 
produzidos pelos modelos numéricos do MOHID e como os dados serão 
representados utilizando o Pós-processador do MOHID.

4.3.1 Abrindo um arquivo HDF

Selecionando-se File -> Open do menu principal do Pós-processador 
do MOHID, um novo arquivo HDF é acrescentado à Árvore HDF.

4.3.2 Selecionando Informações Geográficas

Antes de exibir qualquer dado, o usuário deve especificar a malha 
sobre a qual os dados devem ser representados. Todos os arquivos HDF 
produzidos por qualquer programa numérico do MOHID contêm um grupo 
chamado “Grid”. Neste grupo, o usuário pode encontrar informações da 
malha utilizada durante a simulação. Para visualizar qualquer informação, 
é necessário especificar as seguintes informações geográficas: (i) Malha 
Horizontal “Horizontal Grid”, (ii) Mapeamento “Mapping” e (iii) Coordenada 
Vertical “Vertical Coordinate”.

A Malha Horizontal pode estar em coordenadas métricas (itens 
HDF de conexão X/Y) ou em coordenadas geográficas (itens HDF de 
Longitude e Latitude), dependendo do sistema de coordenadas com o 
qual o usuário deseja representar as informações.

 As Informações de Mapeamento informam ao Pós-processador 
do MOHID quais pontos da malha serão visualizados e quais serão 
considerados “no compute” (não computar) ou zonas “no data” (sem 
dados) (por exemplo, áreas de terra para o MOHID Water). Diferentes 
programas numéricos do MOHID produzem diferentes informações de 
mapeamento (para o MOHID Water, o usuário deve acrescentar ou 
“OpenPoints” ou “WaterPoints” e, para o MOHID Land “BasinPoints”).

As informações sobre a Coordenada Vertical devem ser fornecidas 
no caso de o usuário querer representar os dados como plano XZ, plano 
YZ, plano TZ ou 3D. As informações sobre a coordenada vertical são 
armazenadas no grupo VerticalZ dos itens HDF.
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                                   Figura 4-2: Selecionando a Região de Interesse

Na área Graph Type (Tipo de Gráfico), o usuário pode escolher a forma 
para representar o dado selecionado: (i) como plano XY, (ii) como plano 
XZ, (iii) como plano YZ, (iv) como plano TZ ou (v) como Cubo 3D.

Na área Region of Interest (Região de Interesse), o usuário pode 
definir os limites que serão exibidos e o fator da escala pelo qual a malha 
será ampliada.  Esse fator é particularmente importante se o usuário 
deseja representar os dados como XZ, YZ ou Cubo 3D, uma vez que, 
neste caso, geralmente é necessário dimensionar o eixo Z. É necessário 
considerar que as escalas dos eixos X e Y dependem da malha horizontal 
“Horizontal Grid” que foi escolhida (coordenada métrica ou geográfica), 
enquanto que o eixo vertical é sempre dado em metros. Isso significa que 
para o caso de coordenadas métricas, o usuário pode querer utilizar um 
fator grande (10-10000?) para o eixo Z, enquanto que, para coordenadas 
geográficas, este fator poderia ser bem pequeno (0.1-0.00001?).

4.3.3 Região de Interesse

Depois de selecionar as Informações Geográficas, o usuário deve 
configurar a Região de Interesse, selecionando Settings -> ROI do menu 
principal do Pós-processador do MOHID. Uma janela de diálogo, como 
mostrado na figura 4-2, aparece. Aqui o usuário pode escolher como 
visualizar os dados e definir os limites das matrizes para carregar.
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Na área Layer (Camada) o usuário pode escolher qual plano ele quer 
representar e na área Land Elevation (Elevação do terreno), pode definir 
a profundidade do terreno.

4.3.4 Selecionando as informações para exibir

Há diferentes maneiras de exibir dados: (i) como Mapa de cores “Color 
Map”, (ii) como Isolinhas “Isolines”, (iii) como Campo Vetorial “Vector 
Plot”, (iv) como Partículas Lagrangianas “Lagrangian Particle” e (v) como 
Legenda de Tempo “Time Legend”.

Todo item HDF (esperam-se informações de tempo e de malha) pode 
ser exibido em qualquer tipo de gráfico como mapa de cores. Depois de 
selecionar os itens HDF desejados na árvore HDF, o usuário pode utilizar 
o botão de seleção de cores “Color Selection Button” para acrescentar 
o(s) item(ns) à lista de dados de cor “Color Data List”. Todo item de dados 
HDF (esperam-se informações de tempo e de malha) pode ser exibido 
como isolinhas. Se o tipo de gráfico for definido para TZ graph (gráfico 
TZ) ou 3D Cube (Cubo 3D), as isolinhas não podem ser exibidas. Os 
itens HDF são acrescentados à Lista de Dados de Isolinhas “Isoline Data 
List” com o botão de seleção de isolinhas “Isoline Selection”.

Os campos vetoriais sempre precisam de um componente X e de um 
Y. A escolha dos componentes depende do tipo de gráfico a ser exibido. 
Caso o usuário queira exibir um plano XY, os componentes X e Y normais 
da propriedade que se quer exibir podem ser selecionados (por exemplo: 
velocidade do fluxo). No caso de um plano XZ ou um plano YZ, o usuário 
deve selecionar os componentes corretos.

Para exibir partículas lagrangianas, o usuário deve selecionar a posição 
das partículas (X, Y e Z) e uma propriedade que se deseja utilizar para 
“colorir” as partículas. Somente os dados armazenados em um grupo 
de dados 1D de arquivos resultantes do módulo lagrangiano podem 
ser usados para serem exibidos como partículas lagrangianas. Dados 
armazenados em um grupo de dados 3D pode ser usado como Mapa de 
cores ou isolinhas. Acrescentando-se itens HDF que estão localizados 
no grupo Time (Tempo) na lista Time Selection (Seleção de Tempo) uma 
legenda do tempo “Time Legend” será exibida no canto inferior esquerdo 
da janela OpenGL.

4.3.5 Carregando os dados

Depois de selecionar as informações geográficas, definir a região 
de interesse e selecionar as informações a serem exibidas, o Pós-
processador do MOHID está pronto para carregar todos os dados. 
Selecionando-se Action -> Run OpenGL... na janela principal do Pós-
processador do MOHID, todos os dados selecionados serão carregados 
e a janela principal será fechada. Depois de fechar a janela principal, 
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a Janela OpenGL “OpenGL Window” e a Janela de Ferramentas de 
Imagem “Image Tool Window” aparecerão. Dependendo da quantidade 
de itens de dados previamente selecionados para as diversas categorias 
(Mapa de cores, isolinhas, mapeamento, tempo, etc.), o Pós-processador 
do MOHID determina quantos instantes estão disponíveis para serem 
exibidos.

É possível salvar os itens de dados referenciados escolhidos como um 
arquivo de texto (*.dsd), para que eles possam ser recarregados em um 
uso posterior. Selecionando-se File -> Save DSD do menu principal do 
Pós-processador do MOHID, todos os dados referenciados são salvos. 
Selecionando-se File -> Load DSD, eles são recarregados.

4.4 Janela OpenGL 

A janela OpenGL exibe os dados selecionados e é dividida em várias 
áreas. À esquerda, se encontra a legenda dos mapas de cores e os 
valores das isolinhas. O texto da legenda é colocado abaixo da figura e, 
no canto inferior direito, a data e a hora do instante atual aparecem. O 
restante da janela é ocupado pela figura em si.

Figura 4-3: Janela OpenGL
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4.4.1 Manipulando a vista 

Você pode dar zoom, obter uma visão panorâmica e girar a figura. 
Para fazer isso, clique com o botão direito do mouse sobre a figura. 
Um menu pop-up com as opções disponíveis será exibido. Este menu 
também permite definir e restaurar os pontos de vista (útil para exibições 
em 3D).

4.4.2 Janela de Ferramentas de Imagem

Após o carregamento dos dados, aparece além da janela OpenGL, a 
janela de ferramentas de imagem (veja a Figura 4-4).

                                      Figura 4-4: Janela de Ferramentas de Imagem

Essa janela permite percorrer os instantes passo a passo, pressionando-
se o botão “Render”.  Se você pressionar o botão “Render All”, todos os 
instantes serão exibidos. As setas “<-” e “->” permitem movimentos para 
trás e para frente sem processamento das imagens. Se você pressionar 
o botão “Settings...”, o Pós-processador do MOHID permite que você 
manipule as configurações de imagem.  Se você pressionar o botão 
“Save to File”, as imagens podem ser armazenadas em um arquivo.

4.4.3 Configurações de Imagem

Selecionando-se o botão “Settings...” da janela de ferramentas de 
imagem, a janela de Configurações de Imagem aparece (veja a Figura 
4-5). Aqui é possível definir um conjunto de configurações que indica ao 
Pós-processador do MOHID como a imagem final será processada.
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                                   Figura 4-5: Janela de Configurações de Imagem

A janela de configurações de imagem permite alterar as configurações 
relacionadas à imagem. As configurações de imagens mais comuns são: 
(i) Configurações de Cor “Color Settings”, (ii) Configurações de Isolinha 
“Isoline Settings”, (iii) Configurações Vetoriais “Vector Settings” e (iv) 
Configurações de Partícula “Particle Settings” que estão descritas abaixo. 
Outras configurações são:

• “Scale” – para exibir uma escala métrica;
• “Wind” – para exibir um indicador de vento;
• “Lights” – para definir opções de luz (importante para exibições em 

3D);
• “Texture” – para definir imagens de textura;
• “Flight” – para criar uma animação que “voa” pelos 5 pontos de vista 

definidos;
• “Slices” – acrescenta planos XY, XZ e YZ para uma exibição em 3D;
• “Layers” – define a ordem dos itens (por exemplo: vetor acima das 

isolinhas);
• “Bottom” – cor dos pontos do fundo/terreno;
• “Add. Legend” – legenda adicional a ser colocada sobre a figura;
• “Gridlines” – exibe/oculta as linhas de grade.
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4.4.3.1 Janela de Configurações de Cor

A Janela de Configurações de Cor (Figura 4-6) permite especificar 
como exibir o mapa de cores. Há duas escalas de cores disponíveis: cor 
gradual e cor discreta.

Se você marcar a opção “Normalize”, todos os dados irão variar em 
uma escala entre 0 e 1.

O fator transparência permite escolher a transparência da cor (0 para 
completamente transparente e 1 para completamente visível).

Figura 4-6: Janela de Configurações de Cor

4.4.3.2 Janela de Configurações de Isolinhas

A Janela de Configurações de Isolinhas (Figura 4-7) permite especificar 
como exibir as isolinhas. Há dois tipos disponíveis: valores de isolinhas 
contínuos ou valores de isolinhas discretos.

A largura da linha é a largura em pixels com que as isolinhas são 
desenhadas. O botão de cor permite escolher em qual escala de cor as 
linhas serão baseadas.



MOHID: interfaces gráficas do usuário: manual do usuário

68

Figura 4-7: Janela de Configurações de Isolinhas

4.4.3.3 Janela de Configurações Vetoriais (“Vector Setting Window”) 

A Janela de Configurações Vetoriais (Figura 4-8) permite especificar 
como exibir os campos vetoriais.  Na área das configurações dos vetores 
você pode definir como as setas são exibidas.

O valor da escala “Scale” indica o tamanho dos vetores, tendo em conta 
o módulo de velocidade. Para o presente caso, uma seta representando 
um módulo de velocidade de 1 m/s (um metro por segundo) será 
representada com um comprimento de 500 m (esteja ciente que, no 
caso de coordenadas geográficas, seria representado por 500º, por isso, 
nesse caso você deve selecionar um valor de escala bem pequeno).

Os fatores X e Y “X Factor’’ e ‘‘Y Factor” podem ser usados para 
dimensionar um vetor. Isso é útil para representar planos XZ ou YZ com 
distorção vertical (nesse caso, você deve usar os mesmos valores de 
distorção informados nas Configurações de região de interesse [ROI]).

‘‘X Step’’ e ‘‘Y Step’’ indicam quantas setas serão exibidas. Um valor 
de 3 só exibe a cada terceira seta.

O corte acima “Cut Above” permite omitir a representação de um vetor 
com um módulo de fluxo acima do valor fornecido.

A área vetor de referência “Reference Vector” permite traçar um vetor 
de referência na figura final. Um valor “0” (zero) para o tamanho do vetor 
de referência omite sua representação. 
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Figura 4-8: Janela de Configurações vetoriais

4.4.3.4 Janela de Configurações de Partícula “Particle Setting Window” 

A Janela de Configurações de Partícula (Figura 4-9) permite especificar 
como exibir as partículas lagrangianas.  

O valor “Size” (tamanho) indica o tamanho da partícula. Inicialmente, 
esse valor é sempre definido como “0” (zero), para que nenhuma 
partícula seja exibida. Defina o tamanho para o valor indicado, levando 
em conta se você está usando coordenadas métricas ou geográficas. A 
caixa de seleção “show ROI” (exibir ROI) indica ao Pós-processador do 
MOHID se somente as partículas que estão localizadas dentro das atuais 
configurações de ROI serão representadas ou se todas as partículas.

A coloração das partículas depende da escala de cores que você 
escolher. Se você utilizar uma cor constante, a transparência pode variar 
com os dados que você adicionou como cor de partícula. Isso é útil para 
a visualização de plumas.
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                                   Figura 4-9: Janela de Configurações de Partículas

4.4.3.5 Salvar/carregar Configurações de Imagem 

Você pode salvar as configurações de imagem em um arquivo binário 
(*.ims), para poder carregar as mesmas configurações em um uso 
posterior. Além de todas as configurações de imagem, o ponto de vista 
atual também é salvo. Por favor, observe que essa opção só funciona 
se você quiser representar uma imagem com os mesmos dados (por 
exemplo: mapa de cores e isolinhas “ON”, todos os outros itens “OFF”).

4.4.4 Salvando as Imagens

É possível salvar todas as imagens, selecionando-se Save to File da 
janela de ferramentas de imagem. Na janela de diálogo que aparece é 
necessário especificar o nome das imagens e o diretório onde elas serão 
armazenadas.  Opcionalmente, é possível criar automaticamente uma 
animação dos arquivos e/ou armazená-los em um arquivo ZIP. Para fazer 
isso, é necessário especificar, na caixa de texto “Utilities” (Utilidades), 
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a pasta onde os utilitários (zip.exe e bmp2avi.exe) estão localizados (a 
pasta onde o pacote do MOHID foi instalado).

Por favor, observe que durante todo esse processo a janela 
OpenGL deve permanecer como a janela do topo de sua área de 
trabalho.
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MOHID Time Series Editor (Editor de séries 
temporais do MOHID)

5.1 Introdução

O Editor de séries temporais do MOHID é uma interface gráfica do 
usuário que permite ao usuário visualizar, de uma maneira rápida, os 
dados de séries temporais exigidos ou produzidos pelos programas 
numéricos do MOHID. Normalmente, o Editor de séries temporais do 
MOHID será iniciado diretamente da MOHID GUI, abrindo de modo 
automático o arquivo escolhido pelo usuário (veja a seção 2.3.8 “Alterando 
para o modo pós-processamento”).

O Editor de séries temporais do MOHID é escrito em VB.NET e utiliza 
componentes do Office Web para exibir os resultados. A Figura 5-1 mostra 
a janela principal do Editor de séries temporais do MOHID. 

5
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Figura 5-1: Janela principal vazia do Editor de séries temporais do MOHID 

5.2 Abrindo um arquivo

Selecionando-se File -> Open da janela principal do Editor de séries 
temporais do MOHID, uma nova série temporal é acrescentada à exibição 
em lista no lado esquerdo da janela principal do Editor de séries temporais 
do MOHID. 

5.3 Selecionando séries para exibir

Depois de abrir um novo arquivo, uma janela de diálogo, como mostrado 
na Figura 5-2, aparece. Aqui o usuário tem a opção de selecionar quais 
séries temporais serão exibidas.
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Figura 5-2: Diálogo para selecionar as séries para a exibição

O processo de abertura de arquivos e seleção de séries deve ser 
repetido para todas as séries temporais que serão exibidas. Depois de 
selecionar um conjunto de séries, a janela principal do Editor de séries 
temporais do MOHID deve ser semelhante à mostrada na Figura 5-3.

Figura 5-3: Janela principal com séries do Editor de séries temporais do MOHID 
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5.4 Exibindo os dados

Pressionando-se o botão “Draw Chart” (Desenhar Gráfico) no canto 
inferior direito na janela principal do Editor de séries temporais do MOHID, 
a Janela do Gráfico “Chart Window” que exibe as séries temporais 
selecionadas aparecerá (Figura 5-4).

Figura 5-4: Janela do Gráfico

Ao selecionar comandos da barra de ferramentas na parte superior 
da janela do gráfico, ele pode ser manipulado de maneira similar ao MS 
Excel. Selecionando-se o botão “Save Image”, a imagem atual é salva.

5.5 Salvando o gráfico inteiro

O usuário tem permissão para salvar um gráfico inteiro (valores e 
configurações) por escrito no formato XML. Para fazer isso, pressione 
SaveXML (salvar em XML) e selecione o nome do arquivo. O gráfico 
inteiro pode ser carregado mais tarde, selecionando-se “File -> Open 
XML Time Serie”.
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